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Planning Your Database
Before you set up your database, you should take a little time to think about

how you will be using it. You will need to decide which tables you will use to
maintain your data, what data will go into which fields, and how you want to set
up your Categories. We will briefly discuss each of these items so that you will
have the knowledge you need about CatBase to enable you to set up your data-
base in the best possible way for your intended use of it.

A word that you may not be familiar with, but which you will see used quite
frequently here, is “related.” When we talk about tables being related to each
other, we mean that they are linked by a common factor. For example, a Product
record may be related to a Company record. This means that they are linked
together by the Company’s record number. The point of having related tables is
that the relation makes it possible to “grab” data from the other table. For exam-
ple, you might want to build a directory of every company in your database, and
list all the products that each company supplies underneath the company’s
address. You would be able to tell CatBase that you wanted to use the relation
between the Companies and Products file. Then, when the Company records are
being transferred from CatBase to your page layout program, CatBase will auto-
matically find all the Product records that belong to each company and include
the Product information in the format you have specified.

Note: you will find a Glossary in the Appendix, where you can look up any
words that are unfamiliar to you.

Tables
There are two basic tables that are used for maintaining data in CatBase:

Companies and Products. The data that is maintained in these tables will be used
to create your publication. You can change the names of these tables if you wish
-- this is explained later on in this chapter.

There are also a few tables related to Companies and Products. The Contacts
table is related to Companies, and Product Details is related to Products.
Additionally, Category Entries are related to both Companies and Products, and
Companies and Products can be related to each other. The chart below shows
these tables, how they are related to each other, and how they can be used.
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Table Related to Related Field Use
Companies Products RecordNumber

Contacts
Categories
Memos

Products Companies RecordNumber
Product Details
Categories
Memos
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Maintain information
such as address, tele-
phone numbers, and
other general informa-
tion about companies.
You  can also use this
table for any other type
of information that
requires address data,
such as membership
details for a club or
society. You will be able
to create any number of
contacts for each com-
pany record, and any
number of Product
records may also be
related to one Company
record. If you are going
to publish information
on products only, and
do not need to keep
information on each
product’s supplier (for
example, if they are all
products that your com-
pany makes), you might
not use the Companies
table at all.

Maintain information
on individual products.
Each Product record
can be related to a com-
pany record. You can
make it a requirement
that each Product
record be related to a
Company record. 



Table Related to Related Field Use

Contacts Companies RecordNumber

Product Details Products RecordNumber

Category Companies RecordNumber
Entries Products
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Maintain information
on any number of
Contacts for each
Company. Each Contact
record MUST be related
to one Company record.

Maintain information
on any number of detail
records for each
Product. Each Product
Detail record MUST be
related to one Product
record. Product Detail
records are useful if you
have a number of varia-
tions on a basic product,
for example, a product
might be available in
four different sizes, with
the size (and perhaps
the price) being the only
difference. In that case,
you would have one
Product record with four
Product Detail records.
An example is shown in
Chapter 3.

Each Company or
Product record can be
assigned to any number
of Categories. Once you
have assigned
Categories, you will be
able to search for
records belonging to a
particular Category (for
example, find all
Companies that have
been assigned to
Engineering) and create
publications sorted by
Category. 



Table Related to Related Field Use

Memos Companies               RecordNumber
Products

Fields
Each table contains a number of fields, with each field being used to hold one

particular type of data. For example, in the Companies table there is a field for
the company name, and a number of fields for holding address information. Most
tables have at least one field that you can never change — the record number
field. CatBase needs this field to maintain the integrity of its relations with the
other tables. Record numbers are assigned automatically whenever a new record
is created; you usually don’t need to pay much attention to them. In addition to
the record number field, each table usually has at least one mandatory field. In
the Companies table, the Company Name field is mandatory. In the Products
table, the Product Name field is mandatory. You won’t be able to save a
Company or Product record unless the appropriate mandatory field has an entry
in it. 

We have set up a number of fields in the Companies and Products tables for
specific types of data, but you can use these fields in any way you wish. There
are also a number of “user-definable” fields that have generic names like CO1 or
P1. You can change the names of the fields (this is explained in detail later on in
this chapter).

Each field is designed to hold a certain type of data. There are five basic field
types: numeric, character, Boolean, time, and date. Numeric fields can be real
number, integer, or long integer. Character fields can be of a specific size (for
example, the Company Name field is 70 characters) or unlimited (truthfully, a
character field of “unlimited” size can hold a maximum of 32,000 characters). A
Boolean field holds Yes/No data; it is either True or False. You can see a com-
plete list of fields and their types for each table at any time by choosing Table
and Field Setup … from the Admin menu.

If you are not sure whether to use the Companies or Products tables, or both,
make a list of the pieces of data that you want to put into the database; each
piece of data will go into a different field in the database. This list might include
information that will never appear in a publication. Then see how your data
matches up with the fields in the Companies and Products tables. If you are still
unsure, please contact us! We will be happy to help you figure out the best solu-
tion for your particular requirements, and we won’t charge you for it!
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Memos are a useful
way of setting up
reminders for yourself
or for another CatBase
user. In addition to
being related to
Company and Product
records, Memos can be
free-floating.



Categories
If you are going to use Categories, think about which Categories you want,

and how you need to organise them. Do you need to set them up in a hierarchical
system, or do they all have the same level of importance? If you are planning to
produce a publication in which Company or Product information is sorted
according to the Category to which each record has been assigned, do you need
to have the Categories organised so that there is a level of sub-categories under
each main category heading? Setting up Categories is explained in detail later on
in this chapter.

The Administrator’s Job
You must assign one person as the Database Administrator. This person will

have special responsibilities such as adding or removing users, assigning their
access levels, physically deleting records that have been marked for deletion,
changing field and table names, updating and backing up the database. The
Administrator has a special password, giving him access to the special
Administrator functions. If you purchased CatBase Single-User, you will be the
System Administrator.

We have provided a separate Administrator’s Reference, in which you will find
detailed information regarding the maintenance of the database; topics such as
making backups, deleting records, and various utilities are described in the
Administrator’s Reference. We urge you to read at least the section on making
backups before you begin using your database.

Important note: This section assumes that you have already worked through
the Demo, and are familiar with the basics of CatBase. You must also work
through Chapter One, Installation, which shows you how to start a new database.

➢ Launch CatBase as described in Chapter One. 
If an Open Data File dialogue appears:
➢ Locate your new data file and double-click on it.
If you are using the multi-user (network) version of CatBase, you will see a

network connection window; double-click on the CatBase item in the list.
The password screen appears:
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➢ Enter the Administrator password. This can be found in your Welcome let-
ter (you will be able to change this password to anything you wish).

➢ Double-click on Administrator.

You will see a message box telling you what’s going on as the database
opens. When it says “Click/Press Return to continue”, it is ready to roll. Click
anywhere on the screen or press the Return key on your keyboard.

You’ll see the CatBase main menu screen, with the Admin menu bar:

The Admin menu offers some special functions that are not available to users
who do not have Administrator-level access:
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➢ Follow the steps described below to start using the database. Please fol-
low them in the order in which they are presented.

Changing Table and Field names
This section tells you how to change the table and field names in your data-

base. You do not have to do this now; they can be changed at any time and it
won’t mess anything up.

➢ Choose Table and FIeld Setup … from the Admin menu. You’ll then see
the Table and FIeld Setup window:

There are four pages to this screen: one for each table. Each page lists the
fields available for that table.

Above the list of fields is the table name. To change the name of the table,
simply click in this field and edit it.

The list of fields shows five columns of information:
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Original Field Name
This is the name of the field as it was originally set up in the database. You

can’t change anything in this column.

Field Name To Use
This is where you can specify the field name that you would like to use. To

change a field name, click on it. You will then be able to edit it.

Type
This column tells you what type of field it is. Each field type is described

below:
Boolean: Yes/No, or True/False data. Useful for keeping track of information

such as whether or not the record has been updated since the last mailing.
Boolean fields appear either as “Yes/No” radio buttons or as check boxes.:

Date: Well … this field is for holding dates.
Integer: A whole number (i.e., no decimal point) in the range of plus or minus

32000. Integer fields are useful for such information as number of employees, no.
of family members, and that sort of thing (as long as you are sure it will never
need to hold a number greater than 32,000).

Long Integer: An integer of any size.
Picture: Picture field.
Real: A real number (i.e., one that may have decimal places). Useful for infor-

mation such as prices.
Short Text: A text field of a specific length (which is shown in the Size col-

umn). For example the Company Name field is 70 characters in length -- in other
words, it will hold up to 70 characters. A String field cannot contain Return char-
acters.

Text: A text field that can contain up to 32,000 characters, which may include
Return characters.

Time: A field for keeping time data.

It’s most important that you use the appropriate type of field for the type of
data that you will putting into it. For example, if you want to keep track of the
date on which you received information pertaining to each record, you would use
one of the Date type fields. This will make it possible for you to easily search the
database for records that have not been updated since a certain date, for exam-
ple. If you put the dates into an ordinary text field, you wouldn’t be able to do
searches like that.

Size
This column shows the size of string fields (i.e., the maximum number of char-

acters they can hold).

Show on Screen
In this column you can specify whether or not you want each field to appear

on the data entry screen. You may want to hide fields that are not in use, so that
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they don’t clutter up the screen and provide opportunities for people to enter
data into the wrong fields. To change a field’s display status, click on the appro-
priate line in this column. The display will change:

Click in the check box to toggle it on or off. 

You can click in any column heading to sort the fields by that column. For
example if you wanted to see what String fields were available, click in the Types
column heading. All the fields will be sorted by type.

To change the table and field names for the other tables, click on the appro-
priate tab at the top of the screen.

As you are setting up the field names for each table, you may find it helpful to
open up a record form that table in another window so that you can see where
the various fields are used.

Remember, you are not under any pressure to “get it right” now. You can
come back and change these settings any time you like.

When you have made all the changes you want to make now, click on the
Save button ( ) to close the window and save the changes you’ve made.

Setting Preferences
The next thing you should do is set up certain system parameters and

defaults for your database. 
➢ Choose Setup from the Admin menu.

The Set System Preferences screen opens up: 
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Note that in the rest of this chapter, we refer to the tables by their original
names (Companies, Products, etc.) -- but yours may be different now.

You do not have to set all these defaults now. You can come back and change
them at any time. However, you must at least make sure that the “Products must
be linked to a Company” and the two category requirement selections are appro-
priate for your needs. While these options can be changed at any time, doing so
after you have started entering data could result in your database being inconsis-
tent. 

Following is a description of each item on this screen.

StyleSheet Defaults

Default Font
Whenever you create a new Style Sheet, it will have the font that you choose

here selected. Of course, you’ll be able to change it for each Style Sheet. 

SETTING UP YOUR DATABASE

2.12 V 4.17



Font Size
This is the font size that will be selected as a default when you create new

Style Sheets.

Monetary Unit
This is the symbol that will be used as a default when you export numbers to

be formatted as prices.

Measurement Units
The measurement unit to be used in your Style Sheets.

Exporting

Default Export Format
CatBase can export data in a number of different formats. Here you can select

the format you’re most likely to use, and this will be used as the default when you
set up new Export Style Sheets. This is explained in detail in Chapter 7; for now,
just select your usual page layout program.

When exporting pictures …
If you are going to use pictures to illustrate your publications, you will set up a

Picture element in your Export Style Sheet. In the Picture Element, you specify
how you want the pictures to appear -- the size of the box, background, etc. This
is fine if all the picture boxes are going to be formatted in the same way. If the
pictures require individual specifications, you can set up a picture specification
for each record. This preference lets you tell CatBase which specification to use.
If you select the Export Style Sheet radio button, then the picture box specifi-
cation that has been set up in the Export Style Sheet will always be used. If you
select the Record radio button, then if a picture specification has been set up for
an individual record, then that will be used; if none has been set up, then the
Export Style Sheet picture specification will be used.

SETTING UP YOUR DATABASE

V 4.17 2.13



Faxing

Ignore Dialling Prefix
The CatBase fax facility uses FaxExpress software on the Macintosh (this

facility is not currently available for the Windows version). In FaxExpress, you can
set up a dialling prefix which will automatically be used whenever you send a fax.
This option allows you to tell FaxExpress to ignore the prefix when sending faxes
from CatBase.

National phone code
The fax numbers in your database might contain international dialling codes

(e.g., “+33 ...”) -- because that is how you want them to appear in your publica-
tions. However, if you are sending faxes to those companies, you won’t want to
include the prefix for your own country. If you enter your “home” country prefix in
this field, it will be replaced with a 0 when you send faxes.

Categories

Auto number new categories
When you add new Categories, each Category must have a unique number. If

you don’t care what the numbers are, then select the Auto Number check box
and CatBase will assign numbers for you. If you have specific numbers that you
want to use, un-check this box. You will then have to type in the number that
belongs to each Category.

Dflt Increment
If you have selected Auto number new categories, each new number will

increased by the amount shown here. This can be useful if you want to leave a
gap between numbers to allow for others to be inserted at a later date.

Hint: When you are setting up Export Style Sheets to export data sorted by
Category, you can elect to have the Categories sorted either by name or number.
If you want to control the order in which the Categories will appear (i.e., not in
alphabetical order), then you can simply number them in the order you want
them.
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Category required for Product records
You can assign as many categories as you wish to each Product record.

However, you can decide whether you want to make it a requirement that each
product record be assigned to at least one category:

When this setting is selected (the box is checked), you will not be able to save
a Product record unless at least one Category has been selected for that record.
This will be important if you are planning to create a publication in which prod-
ucts are organised by Category -- if a Product isn’t in any Categories, it won’t
appear in the catalogue!

Company category required
Like the Product category required option, you can also make it mandatory

that each Company record be assigned to at least one category:

Year 2000

CatBase is fully Year 2000-compliant. We have added this feature to simplify
data entry of dates. If you type a date using two digits for the century, CatBase
will decide what the century is according to the pivot year you have selected
here. For example, if the pivot year is 50, CatBase will assume that any year of 50
or later is the 20th century, and any year less than 50 is the 21st. century. In other
words, if you enter 1/1/50 this will be converted to 1/1/1950, or if you type 1/1/49,
this will be converted to 1/1/2049.

Note: All dates are maintained in the database and displayed with a four-digit
year, with one exception: if you click into a date field in which a date in the cur-
rent century has been entered, it will display the century as two digits.

Data Entry
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Record Deletion Tracking
If this option is selected (“On”), CatBase will keep track of Company and

Product records that are deleted. Record deletion is described in detail in the
Administrator’s Reference.

Products must be linked to a company
By default, each product record must be related to a company record in

CatBase. This means that when you create a new Product record, you must
select a Company for that product to be related to. However, this may not be
appropriate for your needs — if you are publishing a catalogue of your own prod-
ucts you don’t need to relate them to a company. To release this requirement, un-
check the Products must be linked to a company check box.

Localisation

Default Country for new Companies records
When you create a new Company record, this entry will appear in the Country

field. If you don’t want anything to appear, just leave this field blank.

Web Server
Setting up the Web Server is described in detail in Chapter 6. It would proba-

bly be a bit premature to get involved in the web server at this point, so please
refer to Chapter 6 when you are ready for it.

When you are satisfied with your settings, click on the Save button to return to
the main CatBase screen.

Changing The Administrator Password
You may want to change your Administrator password for security reasons.

This is not mandatory but we do recommend it if there is any likelihood that other
people will be using the database. To change your password:

➢ At the main CatBase menu, choose Preferences from the File menu.
The following window appears:

SETTING UP YOUR DATABASE

2.16 V 4.17



➢ Click on the Change password button.
✏ Enter your new password. It can consist of up to 15 alphanumeric charac-

ters.
➢ Click on OK.
✏ You will be prompted to enter the new password again to confirm it.
If the second entry doesn’t match the first, you will have to keep trying until

you enter a matching password or cancel.
Don’t forget your password! There is no way to determine what the

Administrator password is once it has been accepted, and if you do not remem-
ber it correctly, you will not be able to log back on as the Administrator. 

Setting up Users
You’ll need to create a User record for each person to whom you want to

allow access to the database. If you have purchased the Single-User version and
you are the only person who will be using the database, you can skip this sec-
tion. 

At the main CatBase screen:
➢ Choose Users from the Admin menu.
The standard Search window opens up:
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➢ Click on New Record.
A new User record opens up:

Name
✏ Enter the new user’s name into the Name field. This will be used by

CatBase when records are created or modified. For example, on the
Memos/Other tab of the Products data entry screen you will find this
information:

SETTING UP YOUR DATABASE

2.18 V 4.17



CatBase automatically keeps track of who created the record and who was
the last person to modify it. This can be useful if, for example, you have hired
somebody to work in your office for a day updating records. At the end of the day
you want to print out all the records she modified so that they can be proofed.
You would set her up as a User before she began work, and then at the end of
the day, simply search for all records with her user name in the Modified by field.
You can also use these fields to quickly find (for example) all records that have
not been modified since a certain date.

ID Number
You can keep track of each user’s personnel number or whatever in this field if

you wish. It isn’t mandatory and it is not used anywhere else in the database.
This field is 12 characters in length.

Title
✏ Enter the user’s title, if you wish, into the Title field. This field is not used

anywhere in the database; it is there for your record-keeping. The Title
field is 20 characters in length.

Password
✏ Enter a password for this user into this field.
NOTE that the password is displayed in a special font,  Whenever you open

the record, the Password field will display a special symbol in place of each letter
of the password. It will look something like this:

There is no way for you to determine what the password was. The
Administrator can, however, change any user’s password by making a new entry
into the Password field. Each user will be able to change his own password at
any time by choosing Preferences from the File menu.

Present Memos on Startup
The Present Memos on Startup check box is selected by default for a

new User. Each time the user logs on to CatBase, the program will check to see if
there are any current Memos for him and will list any it finds. To disable this
option, click in the check box to deselect it. 

Each user can change this option by choosing Preferences from the File
menu.
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Show Category Selection Palette
When you are working with a Company or Product record, you may need to

select Categories for that record to go under. There are two ways to do this: by
clicking on the Add Category button, and by choosing a category from the
Category Selection Palette. The Category Selection Palette is a floating window
that looks like this:

If you are working on a small monitor you may find that this gets in your way,
or perhaps you just prefer to use the other category selection method. If you
don’t want the palette to appear, un-check  the Show Category Selection
Palette check box.

Can Receive Web Messages
When CatBase is running as a web or intranet server, people browsing the

database can send messages to Users if this box is checked. This is explained in
more detail in Chapter 6.

Spell Check Notes in Company Records
If this box is checked, the spelling checker will be activated whenever text in

the Notes field in a Company record is modified.

Spell Check Product Description
If this box is checked, the spelling checker will be activated whenever text in

the Description field in a Product record is modified.

Show Main Palette on Startup
If this box is checked, the CatBase Options palette will be displayed each

time the user starts up the database.

Show Screen Selector on Startup
If this box is checked, the Screen Selector floating palette will be displayed

each time the user starts up the database.

Can Modify Lists
If this box is selected, the User has the authority to modify items in choice

lists. For example, on the contacts screen there is a choice list for Salutation. If
you type in a salutation which is not in the list, and you do not have the authority
to modify lists, you will see a message like this:
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However, if you do have the authority to modify lists, you will be asked if you
want to add the item to the list.

Entry Date
The date on which this User record was created. This date is maintained by

the system; you cannot change it.

Access
There are four levels of access within CatBase: Management, Data Entry 1 (or

DE1), and Data Entry 2 (DE2), and Web Server. You designate access levels for
the users by selecting the appropriate radio button in the Access box on this
screen:

The default access level for a new User is Data Entry 1. A user’s access level
determines which menu bar he will see when he logs on to CatBase. The follow-
ing chart illustrates the options offered under the various menu bars:
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Management

File Data Admin
Options Palette Companies Turn Web Server On
Import Products Flush Web Cache
Memos Product Details Web Connection Monitor
Preferences Categories Web Response Monitor
Send Message Contacts Users
Send Email Export Style Sheets Delete Records from Db
Show Screen Selector Style Sheets Setup
Save Database H&Js Table and FIeld Setup
Quit Colours Zap Table

Email Accounts Lists

Data Entry 1

File Data
Options Palette Companies
Import Products
Memos Product Details
Preferences Categories
Send Message Contacts
Send Email Export Style Sheets
Show Screen Selector Style Sheets
Save Database H&Js
Quit Colours

Data Entry 2

File Data
Options Palette Companies
Memos Products
Preferences Product Details
Send Message Contacts
Send Email
Show Screen Selector
Save Database
Quit

Web Server
The Web Server user has the same menu bar as Management. 

Inactive
You can temporarily deny access to a user by checking the Inactive check

box in his User record. When he tries to log on, he will see a message informing
him that his access has been denied and he should see the System
Administrator, and the database will quit. 
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Categories

If you have selected the appropriate options on the Setup screen, every
Product or Company record entered into the database must be assigned to at
least one Category. You will need to set up one or more Category names before
any Product  or Company records can be entered.

CatBase allows Categories to be set up in a three-level hierarchy. For exam-
ple, you might need a hierarchy like this: 

Level 1  Level 2 Level 3

Hardware
CPUs

Macintosh
IBM
Compaq

Disk drives
Floppy
Hard

Software
Business

Accounting
Database

Personal
Games
Finances

With this kind of setup, it will be easy to create catalogues or directories sort-
ed by category and sub-category. For example, you might put each product into
one or more Level Three categories. Next, you would set up different Style Sheets
for the Level 1, 2, and 3 category headings. Then when the data is exported, you
will see each Level One heading with its Level Two headings underneath, and
underneath each Level Two heading will be its Level Three headings with the
appropriate products shown under each Level Three heading. If this concept isn’t
clear, please take a look at the Companies by Cat + Contacts example Export
Style Sheet in the Demo/tutorial database:

i. Open up the Demo database.
ii. Choose Categories from the Data menu and click on All Records.
iii. Choose Export from the File menu.
iv. Select the Companies by Cat + Contacts Export Style Sheet and, if

necessary, change the export format from QuarkXPress to PageMaker or whatev-
er you prefer, then click on OK.

v. Export the data and then open it up in your page layout program. It
should look something like this:

SETTING UP YOUR DATABASE

V 4.17 2.23



OK,  so your art director would have a fit if you tried to publish something like
this, but it’s just for illustrative purposes. The Level One headings (Hardware and
Software) are shown with their Level Twos sorted alphabetically below (Computer
Systems, Digital Cameras, etc.), and the Level Threes shown under the Level
Twos (in this example, there is only one Level Three category in use: Photoshop
Plug-ins). Under each category heading are listed the companies that have been
put into that Category, along with a list of their contacts.

On the other hand, you might need no more than one level. That’s all right; you
do not have to have Level 2 or Level 3 Categories.

You must, however, have at least ONE Level 1 Category.

Setting up Categories
Level One Categories

➢ At the main CatBase screen, choose Categories from the Data menu.
➢ Click on New Record at the Search dialogue.
A new Level 1 Category record appears:
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Level 1 Category Name
✏ Enter the category name into the Level 1 Category Name field and press

Tab. Category names do not have to be unique. Category names can con-
sist of up to 80 alphanumeric characters.

Category Number
If the Auto number new categories check box was checked in Setup, CatBase

creates a category number for you. The number is calculated by taking the high-
est existing category number and adding the Increment amount to it.  You can
change the number if you wish, by tabbing into the Number field or selecting the
number and typing in the number you want to use. If you change the category
number, the number you enter will become the new highest number for the pur-
pose of creating more new category numbers. For example, let’s suppose that
your current highest category number is 4000 and the increment amount is 10.
When you create a new category, CatBase will assign it the number 4010.
However if you change that number to, say, 3500, the next new category you
enter will be 3500+10. But the next time you launch CatBase, the highest number
will again be set to the highest existing category number in the database. 

If the Auto number new categories check box is not selected in Setup, you’ll
have to enter a category number into the Number field. 

Category numbers must be unique.

Picture Name and HTML Picture Name
Category headings can either be text or pictures. For example, you may want

to use pictograms for your category headings instead of text. To use pictures as
category headings, you simply need to create the pictures and save them in the
appropriate format (i.e., a format that is supported by your intended publishing



destination). We have provided two picture field names for Categories: one for
print, and the other (HTML Picture Name) for use in HTML documents or on the
Web. For example, you might create an EPS for use in your QuarkXPress docu-
ments, and a JPEG for use on the Web.

When you set up Export Style Sheets, you will be able to specify, for each
Export Style sheet, how you want the Category headings formatted (pictures or
text, etc.). 

You will find detailed information about using pictures with various publishing
destinations in Chapter Three.

If you do not need any Level 2 or 3 Categories for this Level 1 Category, click
on the Save button. A new blank Level 1 Category screen will appear; enter
another category or click on the Cancel button to return to the main CatBase
screen.

Level Two Categories

If you need to set up one or more Level 2 Categories for this Level 1 Category:

➢ Click on the Add button above the Level 2 Categories area. 
A blank Level 2 Category screen opens up:

CatBase has entered the appropriate Level 1 category number and name; you
cannot change these on this screen.

✏ Enter a name and number for this category as you did for the Level 1
Category.

✏ You can select Picture Names for Level Two Categories in the same way
as for Level One Categories.
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Level Three Categories
To enter a Level 3 Category, click the Add button above the Level 3

Categories area.

You can have as many categories on all three levels as you need.
You can not have a category number of less than 1.

When you have finished setting up your Categories, we suggest that you print
out a Category Report so that you can check them. To do this:

➢ At the main CatBase screen, choose Categories from the Data menu
and click on All Records.

At the bottom of the category list window there are various buttons:

Show Hierarchy
To review your category hierarchy before you print the report, click on this

button. The view will change to something like this:

➢ Click on one of the Level One Categories to see its Level Twos; click on a
Level Two category to see its Level Threes.

➢ Click on Done to return to the category list.

Print Hierarchy

➢ Click on the Print Hierarchy button to print the category list. You’ll see a
dialogue like this:



You can send the category report directly to the printer, or to a disk file. If you
send it to a disk file, you’ll be able to open the report up in a word processor or
page layout program and format it any way you like. 

Setting Up Your Formatting Options

You will probably want to set up your database so that the hyphenation and
justification tables and colours that you use in your publication are available for
use when designing Style Sheets. There are two options under the Data menu for
this purpose.

H&J … (Hyphenation and Justification) … for XPress users only
If you have set up custom Hyphenation and Justification tables in your

QuarkXPress document, you will need to let CatBase know about them. A new
CatBase database has just one H&J name installed: Standard. Unless you specify
otherwise, this will be applied to any new style sheets you create.

To add new H&Js:
➢ Choose H&J from the Data menu
The following window opens up:
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➢ Click on Add H&J to add a new entry. You’ll be asked for the name of the
new H&J:

Not much to do here!
✏ Type in the H&J name. NOTE: be sure to enter it EXACTLY as it is entered

in your XPress document, including upper and lower case. Otherwise you
will get an error message when you import your data into the Quark docu-
ment using this H&J setting.

➢ Click on OK.
When you create a new style sheet, the H&J names you entered into your

database will be available from the pop-up menu on the Style Sheet screen:

Colours …
CatBase arrives with a basic set of colour choices installed. The basic set is:

Black
Blue
Green
Red
White

If you have designed some custom colours for use in your documents, or if
you want to create some non-standard colours to use in HTML documents, you’ll
want to add them to your CatBase database. To do this:

➢ Choose Colours … from the Data menu.
The Colours window opens up:
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This window shows a list of all the colours that have been set up, along with
their RGB (Red, Green, Blue)  and Hexadecimal values.

RGB Colour Values
For some publishing formats (RTF, for example) the program needs to know

how each colour is mixed using the three basic colours. 

Hexadecimal Colour Values
For HTML documents, you need to supply the hexadecimal value for colours

other than the basic colour set supported by HTML.

To add a new colour, click on the New Colour button.
The Colour editing window looks like this:
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✏ Enter the colour name into the Colour Name field. 

NOTE: QuarkXPress users — Make sure you enter it EXACTLY as it is set up in
your XPress document, including upper and lower case. Also, if the only publish-
ing destination you will be using is QuarkXPress, you do not need to set the
colour values – just make sure that the colour name is spelled correctly.

Now you can create your colour using any one of the following three methods:

RGB Value Sliders
Move one of the three sliders to the right to increase the value of that colour.

As you move the slider, you’ll notice that the other values on this window change
dynamically.

RGB Values
You can type a number directly into the RGB value fields to the right of the

sliders. The maximum value is 255.

Hexadecimal Value
If you know the hexadecimal value of the colour you want to create, you can

type it into the Hexadecimal Value field.

A new colour might look like this:
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➢ Click on OK to save your new colour.
You can have as many Colours as you like.
When you are designing style sheets, your customised list of colours will be

available on the pop-up Colours menu:

Choice Lists
Some fields in CatBase let you pick from a pre-defined selection of choices.

You can always recognise a choice list field because you will see a small black
arrow to the right of the field. For example, the Country field on the first page of
the Companies data entry screen looks like this:

You can enter data into a choice list field either by making a selection from a
pop-up menu, or by entering the data into the field.

To make a selection from the pop-up, click on the little black arrow and hold
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the mouse button down. A list will pop up, from which you make a selection. If
nothing happens when you click on the field label, then no selections have been
set up for that particular field.

For example, if you click on the Country field label, you’ll see a pop-up some-
thing like this:

Move the pointer to the item you want and release the mouse button. Your
chosen item is copied into the field. If you move the pointer off the pop-up list
and release it without selecting anything, nothing is copied into the field.

You can also enter data into pop-up list fields by typing it directly:
➢ Click or Tab into the field
✏ Enter some text. 
➢ Press the Tab key.
CatBase checks to see if the text you have entered matches an item in the

list. If it does, that item is copied into the field. You do not need to enter the com-
plete item; in the Salutation field example above, you could enter the letter d and
press the Tab key. CatBase would find the first match (“Dr.”) and copy that into
the field.

If no matching entries are found, and if you have been given privileges to
modify lists (as described in the Users section of this chapter), you are given the
option of adding your entry to the list:

You can make changes to the entry here if you wish. If you click on Yes, the
item is added to the list and copied into the field. If you click on No, the item is
not added to the list, and it is left in the field just as you entered it. If you added
an item to the list, it will be available in the list immediately.

If you do not have privileges to modify lists, you will see a message informing
you that the item was not in the list, and the field will be cleared.

Sometimes you will want to make a new entry for the list, but CatBase thinks
that it already has a matching entry and will not let you add your new item. For
example, there is a choice list field for Title in the Company Contacts screen.
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Perhaps there is already an item on the list for Director of Marketing, but you
want to add an entry for Director. When you enter Director, CatBase thinks that
you want to use Director of Marketing and automatically uses that entry instead
of letting you add your new entry to the list. There is an easy solution: You can
force CatBase to add your entry simply by preceding it with a + sign. In the
example used here, you would enter “+Director” and press the Tab key. CatBase
immediately adds Director to the list and places that entry into the field.

You can also set up or delete items from your Lists by using the Lists … menu
selection from the Admin menu. This is the best way to set them up when you
know what you want to add and you want to do it quickly. To do this:

➢ Choose Lists … from the Admin menu
➢ Click on All Records
✏ Modify the lists as necessary

There are ten choice lists. Following is a list of the fields that have choice lists,
and where to find them.

Field Location
Actions Memos
Co 2 Company record, Info tab
Country Company record, Address tab
Co 6 Company record, Info tab
Job Function Contacts
P2 Product record, Memos/Other tab
Reason Memos
Response Memos
Salutation Contacts
Titles Contacts

(Your fields may have different names to those shown here if you have
changed them in Table and FIeld Setup).

Make a Backup

We suggest that at this point you Quit from CatBase and make a backup of
your data file. Back it up onto removable media, floppy disk (or set of floppy
disks, depending upon the backup program you use), or another hard disk. You
can then use this data file as your “master” whenever you want to start a new
database.

Multiple Data Files
You can have more than one data file for use with your CatBase program. You

might want to do this if, for example, you want to “freeze” one version of the
database while you are finishing up production, and make a copy to begin updat-
ing for the next issue, or if you want to use CatBase for several different projects.
Each time you launch CatBase by double-clicking on the CatBase program, it will
automatically open the data file that was opened the last time you used CatBase.
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To open a different data file, either double-click on the data file you want to
use, or drag and drop that data file onto the CatBase program icon.

Getting Data Into The Database
Your database is now ready for use. You have one more decision to make: Are

you going to import existing data, or start entering records manually?
You can import data from virtually any other database, spreadsheet, or word

processor, from virtually any computer system. This process is explained in detail
in Chapter 8, Importing Data.

Entering data manually is explained in the next chapter.
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